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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited ("HKEX"), Hong Kong Futures
Exchange Limited ("HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index ("CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited ("CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC"). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in January 2022

Sector Indices vs HSI/ HSCEI

IndexName _

HS Mainland
Oil & Gas Index

HS Mainland
Banks Index

HS Mainland
Properties Index

HSI

HSCEI

+1.7%

. +1.4%

CES120 vs China Theme Indices

Index Name
usce [ B
CES120 Index -3.6% -
e oo o [

MSCI China A 50 Connect Index -7.1%

CSI1 300 Index -7.6%

Equity Index Futures Access Codes N —
HS Mainland HS Mainland

Vendor HS Mainland Banks Properties Oil & Gas CES 120 Hsi HSCEI

Bloomberg BMWA PPTA OGIA CESA HIA HCA

Refinitiv 0#HMBI: 0=HMPI: 0#HMOI: 0#HCHH: 0ZHSI 0#HCEL

WIND MBIF MPIF MOIF CHHF HSIF HHIF

ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg
As at 31 January 2022
Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products

(2022 vs 2021)

Q‘veragzemxrlr Volume . ‘?p:rljnterest. Average Daily Volums Open Interest
280,000 | s ADV (L-A0S) 200,000 50,000 s ADV (L-AxiS) 2 %400,000
HSI Futures 144,809 (+4%) 129,320 (+8%) 240,000 - === Open Interest(R-Axis) e Ope 1 Integest (R-Axis)
200,000 - 150,000 45 000 r 300,000
e 100,000
. - 100, 30,000 + 200,000
Mini-HSI Futures 96,007 (-3%) 16,419 (+0%) 120,000
£0,000 50,000 15,000 F 100,000
40,000 I
g W ELRRREEERN 0 (R R e |
HSI ions 28,315 (+7% 97,571 (+19% o N 3@ B P QR © B D A
Optl ( ) ( ) S ,19 '19 S '19'1« ’]9 q,Q\ q9\ q.d\ q,Q\ qu q,& av
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 11,534 (+3%) 15,101 (+31%)
Average Daily Volume OPE" Interest A:‘ve aei"! Volume v,\?pjn,l:f:‘.
500,000 - m—ADV (L-Axis) 00 000, 45,000 ADV (L-Axis) r 400,000
Open Interest (R-Axis) e Open Interest (R-Axis)
HSI Futures 972 [
. (#631%) 11,193 (+110%) 150,000 F 150,000 - 300,000
Opnons I I I I ; E% 30,000 :
100,000 h t 100,000 | 200,000
i 15,000 ‘
HSI Volatlllty 0 0 50.000 t 50.000 + 100,000
) ) ,
Index Futures
0 o Fr R
. LL >c=ona >0ci S E53E592C =
HS! Dividend @g 2%4288289 kgggq%ggogg%i
Point Index 90 (+200%) 1,921 (269%) 2021 2021 2022
Futures

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2022
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range

HSCEI Correlation (2021)

Hang Seng Index Futures

Contract Multiplier

Notional Value (1 Contract)

Includes the largest and most
liquid stocks listed in Hong Kong

23,802.26 (As at 31 Jan 2022)
19.5
307.33 (Jan 2022)

0.988

HKSS0

HKS1.19Mn (As at 31 Jan 2022)

Transaction Cost*

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

Margin as of 27 Jan 2022

Data Source: HKEX, Bloomberg

NIA

HKS10 / contract
HKS0.54 / contract
Negotiable

HK$S66,150

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 31 January 2022

X

HSI & Top 5 Constituents
('000)
26 1 ——HS| =——VHSI 107 cmmmiSiindex ——Tencent
120 - HSBC — AA
~—— M eituan ——— Baba
110
24
100
24
S0
20 80
70
22 . v 16 60
Now-21 Dec-21 Jan-22 Now-21 Dec-21 Jan-22

Index Strike Aice ('000)

Distribution of HSI Index Options Ol in Month-end

Call

0 2 4
Open Interest ("000)

0 1 2 3 -

Put

Open Interest ('000)



Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products

ADV
(2022 vs 2021) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Carwraces) (Na.of Cowacts)  (No of Comwacss) (No. of Cowracs)
160,000 - e ADV (L-Axis) - 600,000 120,000 | === ADV (L-Axis) r 2,800,000
we Open In (R-goi e Open Interest (R-A00s)
L | - 2,400,000
HSCEl Futures 146,224 (+15%) 338434 (5%) 120,000 - SO0 EIRN0 > 500,000
; L 400,000 80,000 - [2000.00
- 1,600,000
80,000 - 300,000 60,000 -

Al 1,200,000
Mini HSCEI 14,605 (+7%) 5852 (-16%) o 200,000 40,000 800,000
Futures 100,000 20,000 I | 400,000

0+ 0 0 A LA g, 0
-\° v > @ '9 3O ¥ o> B B P 4
HSCEI Options 41316 (-%%) 1,030,860 (+4%) $E S S '9 AL
HSCEI Futures (MoM) HSCEI Options (MoM)
Mini HSCEI Average Daily Volume Open Interest  Average Daily Volume Open Interest

- 1,959 (+17%) 10,909 (+34%) (oo Cowas) urcely (g ke Sty

Options 220,000 | wmm—m ADV (L-A%s) - 600,000 100,000 - ADV (L-Axis) - 3,000,000
Open Interest (R-Axis) w— Op2n Interest (R-As)
- 500,000 80.000 -
HSCEI Futures e Cs0000 w
] 13,045 (+858%) 195490 (+130%) : 50,000 - e
Options 110,000 - I I o 300,000 \’\/-\_\_
40,000
200,000 x
HSCEI Dividend 55,000 SEEE 1,000,000
Point Index 828 (-29%) 57.821 (+9%) - :
Futures °‘ Uy e e e o 0 0
faegs2pasan 8553533882

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2022
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
Correlation with HSI, CES120 (2021),

Correlation with CSI300, FTSE A50
(2021)

Comprises the largest and
|most liquid H shares

8,349.95 (As at 31 Jan 2022)
220
122 .46 (Jan 2022)

0.988,0.918

0.589,0.617

Contract Multiplier

Notional Value (1 Contract)

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

Margin as of 27 Jan 2022

HKSS0

HKS0.42Mn (As at 31 Jan 2022)

Transaction Cost”

N/A

HKS3.5 / contract
HKS$0.54 / contract
Negotiable

HKS24,300

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 31 January 2022

X

110

106

102 -

176
15.6
141
131
121
s
101
9.1
8.1
71
6.0
44
20 |

Index Strike Price ('000)

s H 5| e H SCE |

Call

10 20 30
Open Interest ("000)

40

107 e HSCE —— Ping An

120 { ——Tencent ——CCB
Meituan — Baba

110

100

90

80

70

60 — — —

Nov- Dec-21 Jan-22
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Put

—

—

0 20 40 60 80

Open Interest ('000)



Weekly HS| & HSCEI Options Performance

Weekly HSI Options

Weekly HSI & HSCEI Options Volume

Contract Multiplier

Liquidity Providers

HK$50

Akuna, Eclipse, I-Access, IMC, Maven,
Optiver

Volume
(No. of Contracts)

25,000 -

um Weekly HSI Options
. 20,000 ® Weekly HSCE!l Options
Transaction Cost”
15,000
Stamp Duty N/A
: 10,000
Trading Fee HK$10 / contract
SFC Levy HKS$0.54 / contract 5,000 I I I I I
Commission Rate Negotiable 0 _“_“_"_"_"_"_“_"_“_"_"_"_"_"‘_':"._':"_"_1‘_"
NPT U ORN O -ANMITNDD O eI OO N D
— - NN ANANANNANM

Weekly HSCEI Options

Volume
(No. of Contracts)

Contract Multiplier HK$50 12 000 - e \Weekly HS| & HSCEI Options Call
. T w—\\eekly HSI & El Options Put
Liquidity Providers g«kgna, Eclipse, I-Access, IMC, Maven,
ptiver 8,000
Transaction Cost 4000
Stamp Duty N/A
Trading Fee HK$3.5 / contract 0 B B NS = =
SFC Levy HK$0.54 / contract T e B rOcHmRrE B RsBEE B
FFFFF ~ v ONONANANANANANM
Commission Rate Negotiable

Data Source: HKEX

An investment tool to manage short term event risk

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 January 2022
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2022 vs 2021) _“ No. of Single Stock Derivatives

Stock Futures 8.927 (-7%) 39,055 (+33%) Single Stock Futures
Stock Options 548 117 (-14%) 8,964,619 (+12%) Single Stock Options 125
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av Daily Volume Open Interest  Average Daily Volume Open Interest
(Na. of Cortracs) (Na.of Cotracts) (No. of Cormraces) (Na. of Cowaces)
12,000 1 s ADV (L-Axis) r 45,000 800,000 - ADV (L-Axis) SRUROK LV Stock Futures
10.000 w Open Interest (R-Axis) , - 40,000 we Op Interest (R
v [ 35,000 600.000 i I 8000,000
8,000 - 30,000 ‘ | 6.000.000 Products
5000 25000 00000 . e » 3 A-shares ETFs futures contracts
: + 20,000 4,000,000 » Total 99 stock futures contracts
4,000 [ 15000 00000 |
2,000 I I I [ 10,000 : - 2,000,000
' + 5,000
0 I L. iRRR 0 1o 0
Q'Lb-b‘b%‘ PP IR I, S,
@\'19\'\9\'\9\'19\«19@0 P DD PP g
Stock Futures (MoM) Stock Options (MoM) Stock Options
Average Daily Volume Open Interest Average Daily Volume Open Interest Products .
(N of Canracss) {No of Cawacs  (No.of Corracss) A i (Na.of Cortracss) » 3 A-shares ETFs options contracts
. =mmm ADV (L-Axis) . " s
12'3% s s s ) [ 23’383 1,000,000 Opan intarest (R [ 16:900:000 » Total 125 stock options contracts
12,000 : e e 2000 Market Makers (MMs)
e | 25000 500000 M’\/ 8,000,000 > 3 types of market makers (PMM/ CQMM/
6000 Zg,ogg 400,000 QRMM)
4000 10'800 200.000 4,000,000 » CQMM to provide 50 series continuous
2,000 5,000 quotations
i oy o ol e ——
W Y a & - ]
55553755588 8323833388548
2021 2022 2021 2022

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2022
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Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 31 January 2022)

Index Description de‘.s e Rt e Open Interest
listed in Hong Kong ¢N‘<)>.eo! Contracts)

90,000 -
Contract Multiplier HKSS0 per index point 60.000
Notional Value (1 Contract) HKS271K (As at 31 January 2022)
No. of Liquidity Providers Futures: 4; Options: 6 30.000 I I I I
il 1] . s
Stamp Duty N/A o L R ey R = o o 5§ = © =
Trading Fee HKSS.00/ contract @ § < g 30 2 @ © ‘Z: 8 3
SFC Levy HKS0.54/ contract 2021 202

Average Daily Volume (as of January 2022)
ADV

(No. of Contracts)

40,000 +
30,000 -
20,000
10,000 - I III
N
2021 202

Providing investors with a tool to manage their risk exposure

Volume and Open Interest are Incubatin
to Hong Kong-listed technology companies pe g
Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 31 January 2022

X "



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Daily Volume Since Launch

= Dascrintion Balanced representation from 11 sectors

of top 50 China A shares Volume ,
(No. of Contracts)
Index Level 2,693.11 (As at 31 January 2022)
40,000 -
Index Volatility (30-Day Historical) | 13.1 35,000 -
30,000
Index Avg. Day High-Low Range | 27.46 (January 2022) 25 000
CSI300 Correlation (2021) 0.976 20,000
15,000
FTSE A50 Correlation (2021) 0.939 10.000
o || 11
0 - T T T T T T T T T . |
MSCI China A 50 Connect Index Futures T T T T T T s
el 1t T
Contract Multiplier US$25
Notional Value (1 Contract) US$0.07Mn (As at 31 January 2022) Daily Open Interest Since Launch
Average Quote Size US$0.34Mn (5 Contracts)

Ol
(No. of Contracts)

46,000 -
42,000
Stamp Duty N/A
38,000
Trading Fee Nil until 30 June 2022
34,000
SFC Levy Nil until 15 April 2022
30,000
Margin as of 27 Jan 2022 US$3,730
26,000 —
BT OO RO~ ANMIN DI T OO N DB =
s B S e Gy S0 M e i u s M5 B
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX

* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 January 2022

X



MSCI Asia and Emerging Market Index Futures Performance

representation 38 DM and EM countries and
Index Description ) . Open Interest
regional indices (No. of Contracts)
100,000 -
MSCI Asia and Emerging Market Index Futures 80 000
Contract Multiplier Average USS40 60 000
Notional Value (1 Contract) Average USS49K (As at 31 January 2022) -
No. of Liquidity Providers 14 40.000
20,000
Kol e — > c = o o < > o c
ool = L 223233532888z 3|S
Trading Fee US$0.6-USS1.0 / contract
SFC Levy USS$0.07 / contract 2022
Average Daily Volume (As of January 2022)
ADV
{No. of Contracts)
25,000
20,000
15,000
10.000
5‘°°°|||||II|
0 . .
o a o > c = o™ o 5 = o c
£ 2 <3232 330 2z a5
|
2022

HKEX with the broadest suite of MSCI derivatives products

R the At Tl Skcia Volume and Open Interest continue to growth

Data Source: HKEX

* Exclude commission fees
Information for reference onlv
As at 31 January 2022

X



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

MSCI AxJ

Index Description representation 2 DM countries (excl. Japan)

Open Interest (31 January 2022)

Open Interest
(No. of Contracts)

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2021)

HSCEI Correlation (2021)

and 9 EM countries in Asia
614.40 (As at 31 January 2022)

169
5.23 (January 2022)
0.886

0.898

MSCI AxJ Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Uss100

USSB61K (As at 31 January 2022)
USS0.31Mn (5 Contracts)

0.0 index points (January 2022)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 27 Jan 2022

N/A

USS$0.5/ contract

USS$0.07/ contract

USS$2,290

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv
As at 31 January 2022

X

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

800 -
600
400
200 I
: |
FE2E5335833 5
2021 2022

MSCI AxJ MSCI China MSCI HK

120 - MSCI SG MSC! India MSCI Indbnesia
MSCI Korea MSCI Malaysia MSCI Pakistan
MSCI Philippines MSCI Taiwan MSCI Thailand

110

100 M

90

80 '

Nov-2021 Dec-2021 Jan-2022

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

5-Min Avg. Bid-Ask Spreads (31 January 2022)

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2021)

HSCEI Correlation (2021)

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Stamp Duty
Trading Fee
SFC Levy

Margin as of 27 Jan 2022

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

10 largest and most representative -
HKEX-listed mainland banks stocks HSNS! Fuliros

2,994 71 (As at 31 January 2022) ABC 12003 4 oA
CEB Bank 6818 HK NN 0.38%

20.8 Bank of China 3988 HK mmmmm 0.34%
CITIC Bank 998 HK [ 0.34%
Minsheng Bank 1988.HK W 0.34%
0.308 PSBC 1658.HK W 0.26%
Bankcomm 3328 HK W 0.23%

2.01%

28.38 (January 2022)

0.316

ICBC 1398.HK WM 0.22%
CM Bank 3968 HK W 0.20%
CCB 939 HK WE 0.18%

HKS50

HKS0.15Mn (As at 31 January 2022)

HKS0.75Mn (S Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
76.2 index points (January 2022) 115 - —HSMBI —CCB (939 HK)

—— |CBC (1398 HK) BOC (3988 HK)
N/A 110 4 —— ABC (1288.HK)

NIA 100
H / tract
K$2 / contra 95
HKS0.54/ contract
HKS6,880 oy ' ;
: Nov-2021 Dec-2021 Jan-2022

HSMBI Futures can be used for hedging

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 31 January 2022

X
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Hang Seng Mainland Oil & Gas Index Futures Performance

5-Min Avg. Bid-Ask Spreads (31 January 2022)

Hang Seng Mainland Oil & Gas Index (HSMOGI)

7 largest and most representative
HKEX-listed mainland oil & gas stocks

1,348.06 (As at 31 January 2022)

Index Description

Index Level

Index Volatility (30-Day Historical) | 32.1

Index Avg. Day High-Low Range 16.44 (January 2022)
HSI Correlation (2021) 0.12
HSCEI Correlation (2021) 0.047

Hang Seng Mainland Oil & Gas Index Futures

Contract Multiplier HKSS0
Notional Value (1 Contract) HKSE7K (As at 31 January 2022)
Avg. Quote Size HKS0.34Mn (5 Contracts)
Avg. Bid-Ask Trading Spread 30.3 index points (January 2022)

Liquidity Providers NIA

Transaction Cost"

Stamp Duty N/A

Trading Fee HK$2 / contract
SFC Levy HK$0.54 / contract
Margin as of 27 Jan 2022 HK$3,060

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2022

X

]

Hsuoc Fuures . | - 5

Kuniun Energy 135.HK 0.63%
PetroChina 857 HK 0.29%
Sinopec Corp 386.HK 0.27%

China Oilfield 2883 .HK + 0.18%

CNOOC 883.HK 0.14%

Index & Constituents 3-Month Performance (Rebased to 100)

120 e HSMOGI — PetroChina (857.HK)
— CNOOC (883.HK) Sinopec Corp (386.HK)
— Kunlun Energy (135.HK)
110
P <
Jo N
100 '
90
80 T T
Nov-2021 Dec-2021 Jan-2022

HSMOGI Futures can be used for hedging
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Hang Seng Mainland Properties Index Futures Performance

Hang Seng Mainland Properties Index (HSMPI)

Index Description 10 larggst and @st reprmr?tatlve
HKEX-listed mainland properties stocks
Index Level 4 470.40 (As at 31 January 2022)

Index Volatility (30-Day Historical) | 34.7
Index Avg. Day High-Low Range 110.40 (January 2022)
HSI Correlation (2021) 0.477

HSCEI Correlation (2021) 0.519

Hang Seng Mainland Properties Index Futures

Contract Multiplier HKSS0

Notional Value (1 Contract) HKS0.22Mn (As at 31 January 2022)
Avg. Quote Size HKS1.1Mn (S Contracts)

Avg. Bid-Ask Trading Spread 85.9 index points (January 2022)
Liquidity Providers N/A

Transaction Cost*

Stamp Duty NIA

Trading Fee HKS2 / contract
SFC Levy HKS0.54/ contract
Margin as of 27 Jan 2022 HK$22,350

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2022

X

5-Min Avg. Bid-Ask Spreads (31 January 2022)

Fullshare 607 HK
Kerry Ppt683. HK I 0.55%
Shimao Property 813 HK N 0.33%

1.95%

China Overseas 688.HK - 0.29%
Sino-Ocean Gp 3377.HK 1 0.2%%
Evergrande 3333.HK - 0.2%%
China Vanke 2202.HK N 0.29%%
Country Garden 2007. HK N 0.29%
HSMPI Futures - 0.29%

China Res Land 1109 HK I 0.25%
Longfor PPT 960.HK M 0.24%

Index & Constituents 3-Month Performance (Rebased to 100)

160 - e H SM P - Evergrande (3333.HK)
~— China Overseas (688.HK) =——Country Garden (2007.HK)
China Res Land (1109.HK)
140 - Ty
~ —/\\\.// ot
/
120 A J
BN o~ A
100
80
60
40 ‘
Nov-2021 Dec-2021 Jan-2022

HSMPI Futures can be used for hedging
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CES120 Index Futures Performance

CES120 Index

Index Description

Index Level
Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range

CSI300 Correlation (2021)

FTSE A50 Correlation (2021)

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

6,605.45 (As at 31 January 2022)
196

82.92 (January 2022)

0.847

0.862

5-Min Avg. Bid-Ask Spreads (31 January 2022)

4

CSOP FTSE ASOETF 2822 HK) . 0.21%

XiShares AS0 ETF (2823.HK) . 0.20%

ChinaAMC CSI300 ETF (3188HK) I 0.10%
CES120 Index Futures ¢ 4

Contract Multiplier

Notional Value (1 Contract)
Average Quote Size

Average Bid-Ask Trading Spread

Liquidity Providers

110
Transaction Cost"

Stamp Duty

Trading Fee

SFC Levy

Margin as of 27 Jan 2022

HK$50

HK$0.33Mn (As at 31 January 2022)
HK$1.65Mn (5 Contracts)

88.5 index points (January 2022)
N/A

NI/A

HK$5 / contract
HK$0.54 / contract
HK$17,320

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 31 January 2022

X

CES120 & Top Constituents’ 3-Month Performance

120 e CES120 Index — Tencent CCB
——Ping An -~ China M obile

100

90
Nov-2021

Jan-2022
CES120 Futures can be used to hedge A-share positions

Dec-2021



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTl/<yy><m> HF HTl/<yy><mm>/<strike><t> HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTl<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv 0#HHTI 0#HTI* HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m> HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information =~ MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv 0#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X
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MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM ex
_ China NTR
Information (USD) Index (USD) Index
Vendor Futures Futures
Bloomberg HKCA Index MCYA Index CSIA Index HMSA Index CJEAIndex HJEAIndex HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index
Refinitiv 0#HMAN: O0#HMCA: 0#HCHI: 0#FHMCU: 0#HCHN: 0#HMCN: 0FHMAC: 0FHMAK: 0#HEAN: 0#HMEE: 0HFHMXC:
WIND MANF.HK MCAF.HK MCNF_HK EANF.HK

MSCI EM i MSCI
_ LatAm NTR i MSCI India Indonesia
Information \sp) index [(USD) Index |[Markets (USD) [(USD) Index  |(USD) index NTR (USD)  [index (USD)
Vendor Futures Futures Index Futures |Futures Futures Index Futures |Futures
Bloomberg HQIA Index HQYA Index HMPAIndex HMOAIndex HLCAIndex HRTAIndex HJDAIndex  HMLAIndex HKBAIndex  HQAA Index
Refinitiv 0#HMXK: 0#HMEL: 0#HMEM: O0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP:
WIND MINF_.HK MDNF.HK
MSCI
_ MSCl Japan |MSCI Malaysia [MSCI Malaysia [Zealand NTR e MSCI Pacific  |Philippines ilippi Singapore
Information NTR(USD)  {USD)Index [NTR (USD) NTR (USD)  |(USD) Index Free (SGD)
Vendor Index Futures |Futures Index Futures |Futures Index Futures |[Futures Index Futures
Bloomberg HQBAIndex HJCAIndex  HMYAIndex HKEAIndex  HOPA Index HRPA Index  HRBAIndex HNSAIndex HLEAIndex  HKOA Index
Refinitiv 0#HMJJ: 0#HMJU: OEHMMY: 0#HMMN: 0#HMNZ: O#HMPJ: 0#HMPC: O#HMPH: O#HMPN: 0#HMSG:
WIND MJUF HK MMNF_HK
MSCI
Singapore MSCI MSCI Taiwan
_ Free NTR Singapore MSCI Taiwan |MSCI Taiwan [25/50 NTR MSCI Taiwan |MSCI Thailand MSCI Thailand [MSCI Vietnam |MSCI Vietnam
Information {USD)Index |[NTR (USD) (USD) Index [25/50 (USD) (USD) Index |NTR (USD) (USD) Index |NTR (USD) (USD) Index |NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg  HOBAIndex HKPAIndex HJAAIndex HRCAIndex HRDAIndex HJBAIndex HMTAIndex HKDAIndex HNTAIndex  HKSA Index
Refinitiv 0E#HMGN: 0#HMSN: 0FHMTW: 0BHTWP: 0#HTWN: 0#HMWN: 0FHMTH: 0#HMTN: 0BHMVT: 0FHMVN:
WIND MTWF HK MWNF HK MTNF_HK

Data Source: HKEX

X .



Weekly HSI and HSCEI Options Access Codes

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options” > "Futures/Options Quotation (Short-term)” > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW* HF> <0#HCEIW* HF>

Tele-Trend File->Open->Options->HS| File->Open->0Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

AASTOCKS - 221495
Activ Financial - MXJi<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
cQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJmy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m> HF

Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Mainland Banks
Index

Information Vendor

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv _HSMBI

Mainland Information Vendors

Mainland Banks
Index

Information Vendor

East Money HSMBI

Hexin Flush Financial

Pobo Financial
Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI

MBI
P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI
MBIC

MBIl+Month+Ye
ar

209

MBIF+yymm+H
K

Mainland Mainland
Properties Properties Index
Index Futures
221425
=0200800.HK MPI/16K HF
837451 870810
MSMPI Index PPTA Index
MPI
MPR MPI
MSMPI MPI
SEHK. HHSMPI P11224
MPImy
HSMPI 0#HMPI:
Mainland Mainland
Properties Index | Properties Index
Futures
HSMPI MPI
MPIC
MPI+Month+Year
999902 209
HSMPI MPIF+yymm+HK

Mainland Oil Mainland Oil &
& Gas Index Gas Index
Futures
221415
=0201000.HK MOI/16K HF
837451 870808
HSMOGI Index OGIA Index
MOl
MOG MOI
MOGI MOI
SEHK,(I;-IIHSMO P11222
MOImy
HSMOGI 0#HMOI:
Mainland Qil Mainland Oil &
& Gas Index Gas Index
Futures
HSMOGI MOI
MOIC
MOI+Month+Ye
ar
999903 209
HSMOGI MOIF+yKymm+H
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv HKCES120 0#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I.CES120 Fn:CHH\WMYYDD
Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF +yymm+.HK
Eti:’eng Zhou Esunny Information Technology Co, _ CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



